ECDL Module 3
Word Processing
Office 2003 Edition
ECDL Syllabus Five
## ECDL Approved Courseware

- ECDL approved courseware

## Course Set up Instructions

- Course set up instructions

## Using the Application

### Working with Documents

- Starting Word using the Windows Start menu
- Closing the Word program using the Close button
- Closing the Word program using a keyboard shortcut
- Opening a document within Word
- Closing a document within Word
- Creating a new document based on the default template
- Creating a memo based on a template
- Creating a fax title page based on a template
- Creating an agenda based on a template
- Creating a new folder in which to save your document
- Saving a document using another name
- Saving a document using a text format
- Saving a document using an earlier Word format version
- Saving a document using the RTF format
- Saving a document as a template
- Opening multiple document files
- Opening a continuous block of document files at the same time
- Secret way of closing all open documents
- Opening a non-continuous block of document files at the same time
- Switching between open documents using the Taskbar
- Switching between open documents using a keyboard shortcut
- Switching between open documents using the Windows menu

### Enhancing Productivity

- Modifying the 'user name' preference options within Word
- Modifying the default folder preference option within Word
- Modifying the save options within Word
- Using Word help to get more information about Save options
- Displaying the Office Assistant Help
- Hiding the Office Assistant
- Using the Office Assistant
- Printing a help topic
- Using the zoom tool
- Displaying or hiding the toolbars

## Document Creation

- Document creation

## Entering Text

- Entering text

### Displaying a document using different view modes

- Inserting a word

### Inserting a new paragraph

### Inserting special symbols

### Using AutoCorrect to insert symbols the easy way

## Selecting and Editing Text

- Selecting non-printing characters
- Selecting a character
- Selecting a word

---

**FOR USE AT THE LICENSED SITE(S) ONLY**

© Cheltenham Courseware Pty. Ltd. 1995-2010 www.cheltenhamcourseware.com.au tours are strike a blow
Removing number formatting from a list........................................................................63
Adding numbering to a list using the Numbering button............................................63
Removing bullet formatting from a list.........................................................................62
Applying bullets to a list..............................................................................................62
Modifying line spacing..................................................................................................60
Modifying paragraph spacing.......................................................................................59
Good Practice: Use paragraph spacing rather than using the Enter key......................58
Removing tabs using the Ruler.......................................................................................57
Setting tabs using the Ruler.........................................................................................56
Types of tabs................................................................................................................56
Aligning text within a document...................................................................................55
Indenting a paragraph from the left...............................................................................55
Indenting a paragraph from the right............................................................................55
Indenting the first line of a paragraph.........................................................................54
What are 'Tab Stops'?....................................................................................................54
Deleting a paragraph......................................................................................................54
Creating a paragraph......................................................................................................54
Merging paragraphs........................................................................................................54
Inserting a soft carriage return (manual line break)....................................................53
Removing a soft carriage return (manual line break)..................................................53
Good practice when aligning and indenting text..........................................................53
Changing the text case...................................................................................................52
Setting hyphenation options.........................................................................................51
Applying different background colours to selected text.............................................51
Changing the text case...................................................................................................50
Setting hyphenation options.........................................................................................50
Applying colours to selected text................................................................................50
Applying subscript or superscript formatting.............................................................49
Changing the font size or font type...............................................................................49
Formatting text as bold, italic or underlined...............................................................49
Modifying existing text..................................................................................................48
Removing existing text..................................................................................................48
Finding text within a document....................................................................................47
Finding and replace text within a document...............................................................47
Copying text within a document..................................................................................46
Copying text from one document to another.............................................................46
Moving text within a document....................................................................................45
Moving text from one document to another...............................................................45
Deleting a character.......................................................................................................44
Deleting a word................................................................................................................44
Deleting a line..................................................................................................................44
Deleting a sentence.........................................................................................................44
Deleting a paragraph.......................................................................................................44
Deleting a block of text.................................................................................................44
Using Undo to reverse your last action..........................................................................44
Repeating an action using Redo....................................................................................43

FORMATTING..................................................................................................................50

TEXT FORMATTING.........................................................................................................50
Changing the font size or font type................................................................................50
Formatting text as bold, italic or underlined...............................................................50
Applying subscript or superscript formatting.............................................................50
Applying colours to selected text................................................................................50
Applying different background colours to selected text.............................................50
Changing the text case...................................................................................................50
Setting hyphenation options.........................................................................................50

PARAGRAPH FORMATTING...........................................................................................50
Deleting a paragraph......................................................................................................50
Creating a paragraph......................................................................................................50
Merging paragraphs.......................................................................................................50
Inserting a soft carriage return (manual line break)....................................................50
Removing a soft carriage return (manual line break)..................................................50
Good practice when aligning and indenting text..........................................................49
Aligning text within a document...................................................................................49
Indenting a paragraph from the left...............................................................................49
Indenting a paragraph from the right............................................................................49
Indenting the first line of a paragraph.........................................................................49
What are 'Tab Stops'?....................................................................................................49
Types of tabs................................................................................................................49
Setting tabs using the Ruler.........................................................................................48
Removing tabs using the Ruler......................................................................................48
Good Practice: Use paragraph spacing rather than using the Enter key......................48
Modifying paragraph spacing......................................................................................48
Modifying line spacing..................................................................................................47
Applying bullets to a list..............................................................................................47
Removing bullet formatting from a list........................................................................47
Adding numbering to a list using the Numbering button............................................47
Removing number formatting from a list.....................................................................47

FOR USE AT THE LICENSED SITE(S) ONLY
© Cheltenham Courseware Pty. Ltd. 1995-2010 www.cheltenhamcourseware.com.au tours are strike a blow
### TABLE OF CONTENTS

**STYLEs**
- Applying character styles .......................................................... 69
- Applying paragraph styles ............................................................ 69
- Copying formatting using the Format Painter ................................. 70

**OBJECTs**

**TABLE CREATION**
- Creating a table using the Insert Table button .............................. 71
- Entering data into a table .............................................................. 71
- Selecting elements within a table, using the Table drop down menu 72
- Inserting a column into a table .................................................... 72
- Inserting a row into a table ........................................................ 73
- Deleting a row within a table ....................................................... 73
- Deleting a column within a table ................................................ 73

**TABLE FORMATTING**
- Specifying row height ................................................................. 74
- Specifying column width ............................................................ 74
- Modifying a cell border line style ............................................... 76
- Specifying a border style, width and colour .............................. 77
- Applying shading to cells within a table ..................................... 79

**GRAPHICAL OBJECTs**
- Inserting Clip Art ........................................................................ 80
- Inserting a picture from a picture file ........................................... 83
- Inserting a chart into a document ................................................. 83
- Inserting an AutoShape .............................................................. 85
- Selecting a graphic ..................................................................... 87
- Copying a graphic within a document ........................................ 88
- Copying a graphic between open documents ............................ 89
- Moving a graphic within a document .......................................... 89
- Resizing a graphic within a document ......................................... 90
- Deleting a graphic ................................................................. 91

**MAIL MERGING DOCUMENTs**
- What you need to learn about mail merging .............................. 92
- What is “Mail Merging”? ............................................................ 92
- Creating and printing mail merged letters ................................ 92
- Creating and printing mail merged address labels ..................... 104

**PREPARING TO PRINT DOCUMENTs** ........................................... 118

**SETTING UP DOCUMENTs**
- Document formatting options ................................................... 118
- Setting the paper size ................................................................. 120
- Setting the page orientation ...................................................... 121
- Setting margins using the Page Set-up command ...................... 122
- Good practice: Use page breaks rather than inserting spaces .... 122
- Inserting and deleting a hard (manual) page break .................... 122
- Creating a header or footer ...................................................... 122
- Modifying a header or footer .................................................... 123
What are Word Fields?.................................................................................................................123
Using the Header and Footer toolbar..................................................................................124
Numbering pages within a document..................................................................................125
CHECKING AND PRINTING DOCUMENTS..................................................................................126
Spell Checking your documents..............................................................................................126
Adding a word to the custom dictionary...............................................................................126
Manually checking your work................................................................................................126
Specifying what to print........................................................................................................127
Specifying the number of copies required...............................................................................128
Printing a document.............................................................................................................128
Investigating the installed printers........................................................................................128
Printing using the default printer..........................................................................................129
ECDL Approved Courseware

ECDL Foundation has approved these training materials developed by Cheltenham Courseware and requires that the following statement appears in all ECDL Foundation approved courseware.


Cheltenham Courseware is an entity independent of ECDL Foundation and is not associated with ECDL Foundation in any manner. This courseware may be used to assist candidates to prepare for the ECDL Foundation Certification Programme as titled on the courseware. Neither ECDL Foundation nor Cheltenham Courseware warrants that the use of this courseware publication will ensure passing of the tests for that ECDL Foundation Certification Programme. This courseware publication has been independently reviewed and approved by ECDL Foundation as covering the learning objectives for the ECDL Foundation Certification Programme.

Confirmation of this approval can be obtained by reviewing the Partners Page in the About Us Section of the website www.ecdl.org.

The material contained in this courseware publication has not been reviewed for technical accuracy and does not guarantee that candidates will pass the test for the ECDL Foundation Certification Programme. Any and all assessment items and/or performance-based exercises contained in this courseware relate solely to this publication and do not constitute or imply certification by ECDL Foundation in respect of the ECDL Foundation Certification Programme or any other ECDL Foundation test. Irrespective of how the material contained in this courseware is deployed, for example in a learning management system (LMS) or a customised interface, nothing should suggest to the candidate that this material constitutes certification or can lead to certification through any other process than official ECDL Foundation certification testing.

For details on sitting a test for an ECDL Foundation certification programme, please contact your country's designated National Licensee or visit the ECDL Foundation's website at www.ecdl.org.

Candidates using this courseware must be registered with the National Operator before undertaking a test for an ECDL Foundation Certification Programme. Without a valid registration, the test(s) cannot be undertaken and no certificate, nor any other form of recognition, can be given to a candidate. Registration should be undertaken with your country’s designated National Licensee at an Approved Test Centre.

© Cheltenham Courseware Pty. Ltd. 1995-2010 www.cheltenhamcourseware.com.au tours are strike a blow
Course Set up Instructions

Instructions for the Course Tutor:

- You should always check your installation files using an up-to-date virus checking program.
- You need to copy all the exercise files and folders to a folder called **Word 2003 course** (under the **My Documents** folder).
- At the end of the course, take a copy of the samples folder containing any files that the student has modified for your records (if required). Then delete the folder containing the samples.
- At the end of the course undo any changes the student has made to the program settings or to the Windows settings.
Using the Application

Working with Documents

Starting Word using the Windows Start menu
- If necessary switch on your computer and enter the necessary Log-on ID and password, so that the Windows Desktop is displayed.
- Click on the Start button to display the Start menu.
- Click on Programs.
- Click on the Microsoft Office sub-menu and then click on the Microsoft Office Word 2003 button.

Note: Depending on your version of Windows, your Microsoft Office Word 2003 button may be located within a different sub-folder.

Closing the Word program using the Close button
- Click on the Close button displayed at the top right of the Microsoft Word window.

Closing the Word program using a keyboard shortcut
- Restart the Word program using the method previously outlined. Close the program using the keyboard shortcut Alt+F4.

Opening a document within Word
- Restart Microsoft Word. To open a document click on the Open button within the Standard toolbar.
- This will display the **Open** dialog box.

- By default the **Open** dialog box will display the contents of the **My Documents** folder. If you look carefully you will see a sub-folder called **Word 2003 Course** displayed within the list of sub-folders. Click once on this folder to select it, as illustrated.
- Click on the Open button within the dialog box to view the contents of the **Word 2003 Course** folder, as illustrated below.
• Select a Word document file called **First Document**, as illustrated below.

![Image of selecting a Word document file](image)

• Click on the **Open** button and you will see the contents of the document displayed, as illustrated below.

![Image of viewing a Word document](image)

**Congratulations**

*If you can read this you have successfully opened a file within Microsoft Word.*

**Closing a document within Word**

• Click on the **Close** button displayed at the top-right of the document window. Be sure to click on the **Close Window** button, (as opposed to the **Close** button).
**TIP**: The keyboard shortcut for closing the active document is **Ctrl+F4**. This will just close the document that you are working on, while leaving other Word documents open.

### Creating a new document based on the default template

- Click on the **New** button and a new blank document will be displayed on the screen. This document will be based on the default template within Word.

- Type in your name. To save the document click on the **Save** button.

- This will display the **Save As** dialog box, as illustrated below.
If necessary double click on the **Word 2003 Course** folder to change to that folder. The dialog box should display the contents of the **Word 2003 Course** folder, as illustrated below.

Notice that the Microsoft Word program suggests a file name based on the contents of the document (i.e. *your name*).

Within the **File name** section of the dialog box, enter the file name as:

**My Very First Word File.**

Click on the **Save** button to save the file and then close the file.
Creating a memo based on a template

- From the File menu, select New to display the New Document task pane.

- You will see a range of options displayed within the Task Pane (displayed to the right of the main Word window).

- In this case we want to create a professional looking memo. Within the Templates section, click in the On my computer section and the following dialog will be displayed.
• Click on the **Memos** tab and select the **Professional Memo** button which displays the following.

![Templates](image1)

• Clicking on the **OK** button will display the outline of a memo on your screen, which you can adapt.

![Templates](image2)
Where the text **Company Name Here** is displayed, enter a fictitious company name.

- Experiment with customising the rest of the menu.
- Save the document as **My First Memo**, and then close the document.

### Creating a fax title page based on a template

- From the **File** menu select **New** to display the **New Document** task pane.
- You will see a range of options displayed within the Task Pane (displayed to the right of the main Word window).
- In this case we want to create a professional looking fax page. Within the **Templates** section, click in the **On my computer** section and the **Templates** dialog will be displayed.
- Click on the **Letters & Faxes** tab and select the **Elegant Fax** button.
Clicking on the **OK** button will display the outline of a fax on your screen, which you can adapt.

Experiment with customising the fax page.

Save the document as **My First Fax**, and then close the document.

### Creating an agenda based on a template
- From the **File** menu select **New** to display the **New Document** task pane.
- You will see a range of options displayed within the Task Pane (displayed to the right of the main Word window).
In this case we want to create an agenda. Within the **Templates** section, click in the **On my computer** section and the **Templates** dialog will be displayed.

Click on the **Other Documents** tab and select the **Agenda Wizard** button.

Clicking on the **OK** button will display the first page of the Agenda Wizard.
• Click on the **Next** button to accept the default settings for the next few pages on the Wizard until you get to the final page.

• On the last page of the Wizard, click on the **Finish** button and you will see the agenda displayed, as illustrated below.

![Agenda](https://example.com/agenda.png)

- **Meeting called by:**
  - **Facilitator:**
  - **Timekeeper:**
- **Type of meeting:**
- **Note taker:**
- **Attendees:**

- Scroll down the document and have a quick look at what has been created.
- Save the document as **My First Agenda**, and then close the document.

### Creating a new folder in which to save your document

- Click on the **File** drop down menu and select the **Save As** command. Click on the **Create New Folder** button, displayed within the **Save As** dialog box. This will display the **New Folder** dialog box.

- Enter the name of the new folder (in this case **My Data**), and then click on the **OK** button. This folder will then be automatically displayed within the dialog box.
- Click on the **Save** button to save the file.

### Saving a document using another name

- From the **File** menu select the **Save As** command and enter a new file name (in this case **My Memo 2**).
- Save the file. Close the file.

**TIP:** The keyboard shortcut to display the **Save As** dialog box is **F12**.

### Saving a document using a text format

- Open a file called **File formats**, contained within the **Word 2003 Course** folder.
• From the File drop down menu, click on the Save As command.
• Enter a file name, in this case My Text File.
• Click on the down arrow to the right of the Save As Type box, and select the type of file format that you wish to save the file as (in this case Plain Text).

![Sample image of a file format selection]

• Click on the Save button to save it in the selected format. Close the document.

**Saving a document using an earlier Word format version**

• Open a file called File formats, contained within the Word 2003 Course folder.
• From the File drop down menu, click on the Save As command.
• Enter a file name, in this case My Earlier Version File.
• Click on the down arrow to the right of the Save As Type box, and select the type of file format that you wish to save the file as (in this case Word 97-2003 & 6.0/95 RTF).

![Sample image of a file format selection]

• Click on the Save button to save it in the selected format. Close the document.

**Saving a document using the RTF format**

• Open a file called File formats, contained within the Word 2003 Course folder.
• From the File drop down menu, click on the Save As command.
• Enter a file name, in this case My RTF File.
• Click on the down arrow to the right of the Save As Type box, and select the type of file format that you wish to save the file as (in this case Rich Text Format).
• Click on the **Save** button to save it in the selected format. Close the document.

**Saving a document as a template**

• Open a file called **File formats**, contained within the **Word 2003 Course** folder.
• From the **File** drop down menu, click on the **Save As** command.
• Enter a file name, in this case **My First Template**.
• Click on the **down arrow** to the right of the **Save As Type** box, and select the type of file format that you wish to save the file as (in this case **Document Template**).

• You will notice that the dialog box now changes to display the contents of a special **Templates** folder. This is normally where you would store your template files. In this case we will store the template file in the same folder as your other sample work files.
• Click on the **My Documents** button displayed down the left side of the dialog box. You will now see the contents of the **My Documents** folder displayed, as illustrated below.

![Save As dialog box](image)

**File Name:** `File formats.dot`  
**Save as type:** `Document Template (*.dot)`
• Double click on the **Word 2003 course** folder to change to that folder.
• Click on the **Save** button to save it in the selected format. Close the document.

### Saving a file using a software specific file extension
- In some cases you may wish to specify a file extension name. For instance, you may want to save a database file, not as a text only file, which by default will have a file name extension of `.txt`, but as a text file using a `.csv` file name extension.
- As an example, open a file called **Weekly sales**. This is made up of data that is separated by tab spaces. This is a very common format used to store lists of contact details.
- Click on the **Save** button and use the **Save as type** option to select the **Plain Text** option.

![Save as type options](image)

- Enter a name along with the file name extension, such as **Contacts.csv**.
- When you click on the **Save** option you may see a **File Conversion** dialog box, in which case select **Windows (Default)** and then click on the **OK** button.

---

**SAMPLE**
Closing on file before continuing.

**Opening multiple document files**

- You can have lots of Word files at the same time. You can open the documents one at a time or you can open many files at the same time.

**Opening a continuous block of document files at the same time**

- Click on the **Open** button in the Word toolbar, which will display the Open dialog box.
- Click on the first file of the block you wish to select, (in this case select the first file displayed in the list) and then while depressing the **Shift** key, click on the last file of the required block (in this case click on the sixth file in the list). When you release the **Shift** key the entire block will remain selected, as illustrated below.
Click on the Open button and all the selected files will open.

Secret way of closing all open documents
To close all open files, hold down the Shift key whilst clicking on the File drop down menu and then select the Close All command.

Opening a non-continuous block of document files at the same time
Click on the Open button in the Word toolbar, which will display the Open dialog box.
Click on the first file that you wish to select (in this case the first file on the list) and while keeping the Ctrl key depressed, click on the other files that you wish to select (click on a few at random to illustrate the principle). When you release the Ctrl key, the selected files will continue to be highlighted, as illustrated below.
Click on the **Open** button and all the selected files will open.

Close all open files.

### Switching between open documents using the Taskbar
- Start Microsoft Word.
- Open any three files.
- To change from one document to another, simply click on the required document, as displayed within the Taskbar at the bottom of your Windows screen.

### Switching between open documents using a keyboard shortcut
- Press the **Ctrl** key and keep it held down.
- Repeatedly press the **F6** key. When you release the **Ctrl** key the document that is displayed will remain displayed on the screen.
Switching between open documents using the Windows menu

- You can also experiment with using the Window drop down menu to switch between documents.

- Close all open files and then close the Word program

Enhancing Productivity

Modifying the 'user name' preference options within Word

- Start the Word program.
- Click on the Tools drop down menu and select the Options command.
• This will display the **Options** dialog box.

![Options dialog box](image)

• Click on the **User Information** tab within the dialog box, and see the sort of information which is stored here. You can change the user name and once you have confirmed this change, Microsoft Word can use this information within new documents that you create. To change the user name to your own name, click within the **Name** field and type in your name. You can also add your initials and mailing address.
Click on the **OK** button to close the dialog box.

**Modifying the default folder preference option within Word**

- Click on the **Tools** drop down menu and select the **Options** command.
- Click on the **File Locations** tab within the dialog box.
- Select **Documents** within the **File Types** section. The default folder is the folder which will, by default, be displayed within the **Open** or **Save** dialog boxes in Word. Normally this will be set to the folder **My Documents**.
Double click on the My Documents listing and you will see the Modify Location dialog box displayed, as illustrated below.
Select the **Word 2003 Course** folder and then click on the **OK** button. The dialog box will now list the **Word 2003 Folder** against the **Documents** listing.

Click on the **OK** button to close the dialog box.

Close Microsoft Word. Reopen the Word program and click on the **Open** button within the toolbar. You should now see that, by default, files within the **Word**
2003 Course folder are displayed. Close the dialog box without actually opening any files.

Modifying the save options within Word
- Click on the Tools drop down menu and select the Options command.
- Click on the Save tab within the dialog box, and you will see the following.

- **Always create a backup copy**: As the name suggest creates an automatic backup copy of a document, every time you save the document.
- **Allow fast saves**: Saves only changes made to a document rather than the entire document, making the save process much faster.
- **Save AutoRecover info every**: You can set a time interval, which will force Word to automatically save your work periodically.
Using Word help to get more information about Save options

- If you click on the question mark icon (at the top right of the Options dialog box a help screen is displayed.

- Within this Help dialog box, click on 'Save', and you will see more information about the various Save options that you can modify.

- Have a quick read through the various options, and then close the Help window.

  **TIP**: A quick way to close a window, such as the help window, is to select it and then press **Alt+F4**.

Displaying the Office Assistant Help

- The Office Assistant is displayed by default. If the assistant has been hidden and you wish to reactivate it, select **Show The Office Assistant** from the Help menu.
Hiding the Office Assistant

- Right click on the Office Assistant and from the menu displayed, click on the Hide command.

- Before continuing, re-display the Office Assistant.

Using the Office Assistant

- Click on the Office Assistant and you will see a text box displayed.

- Type in a question such as **How do I make text display in bold?**
Click on the Search button and you will see the following displayed down the right side of your screen.

In this case click on Apply bold formatting. You will see the following displayed.
As you can see this help facility is a very easy way to learn about using the features available within the Word program.

Experiment with asking a few more questions, into the questions box which is displayed at the bottom-right of your screen.

Try searching for information about **Keyboard Shortcuts**. You will find that there are all sorts of keyboard shortcuts within Word to help you edit and format documents.
Printing a help topic

- If you look at the Help window, you will see there is a Print button towards the top-left of the window. Try displaying a help topic and then click on the Print button to print the information.

- Hide the Office Assistant before continuing.

Using the zoom tool

- Open a document called Little and large.
- Use the Zoom button on the Standard toolbar to quickly zoom to certain settings. Click on the down arrow next to the Zoom button to display a drop down list of pre-set screen zoom values.
Experiment using high and then low zoom levels.

**NOTE:** Zoom does not change the actual size of the text within a document. It only changes the size as displayed on the screen.

When you have finished experimenting, reset the value to **Page Width** setting.

**Displaying or hiding the toolbars**

- To display a toolbar, select the **Toolbars** command from the **View** menu to display the **Toolbars** drop down menu. A list of toolbars is displayed. Select the toolbar you want to display or hide by clicking on it within the list. Experiment!
• Try displaying all the toolbars at the same time. As you can see this gets very crowded.
• Before continuing, make sure that only the **Standard** and **Formatting** toolbars are displayed.
Document Creation

Entering Text

Displaying a document using different view modes

- Open a file called Look At Me.
- Experiment with clicking on the View drop down menu and viewing the effect of selecting various views such as:
  - Normal
  - Web Layout
  - Print Layout
  - Reading Layout
  - Full Screen

As you will see ‘Print Layout’ gives a good impression of how the printed page will look. The ‘Normal’ view can display very strange looking results!
- When you have finished reviewing the document using the Print Layout view.
- Close the document.

Inserting a word

- Open a file called Inserting Data.
- Insert the word Microsoft before the word ‘Word’ at the beginning of the document. To do this just click before the word that you wish to insert the new
word in front of. The insertion point will move to that position on the screen. Then start typing.

**Inserting a new paragraph**
- Click just after the end of the last word within the document. Press the Enter key two times. Type in a short paragraph of text (about why you are learning how to use a word-processor).

**Inserting special symbols**
- Click just after the end of the last word within the document. Press the Enter key two times. Click on the Insert drop down menu and select the Symbol command.

- This displays the Symbol dialog box. You can select a symbol and then click on the Insert button to insert the symbol into the document.
• In this case insert the Copyright character and then click on the Close button to close the dialog box.


c

• Press the space bar and then type in the text Cheltenham Courseware to assign copyright.
• Save the document and then close the document.

Using AutoCorrect to insert symbols the easy way
• Open a file called Autocorrect.
• Try entering the following, followed by pressing the space bar, and see what happens

(c)
(r)
(tm)

• Save the changes to your document and close the file.

Selecting and Editing Text

Displaying non-printing characters
• Open a document called Display.
• Click on the Show/Hide button, located within the Standard Toolbar and view the effect on the document.

• You should be able to see the following:

Paragraph Marks.

Space between words.

Manual Line Breaks.

Tab Spaces

• Before continuing, re-click on the Show/Hide button located within the Standard Toolbar to hide the non-printing characters.
• Close the document.

Selecting a character
• Open a file called Selecting Data.
• Click just in front of the character you want to select (in this case in front of the first character in the blue paragraph).
• Press the Shift key (and keep it pressed).
• Press the Right Arrow key.
• Release the Shift key.

The screen will resemble that below.

In many cases you need to select applying formatting information

• Now that we have selected the character, we will apply a change to the selected character. Click on the down arrow to the right of the Font Colour button and clicking on a colour. That colour will then be applied to the selected character.

Selecting a word
• Double click on the second word in the blue paragraph, as illustrated. Now the word is selected, apply a different font colour to the selected word.

Selection Techniques

In many cases you need to select applying formatting information
Selecting a line

- Move the mouse pointer to the left of the second line within the blue paragraph and wait until the mouse pointer changes from an 'I' bar to an arrow pointing upwards and to the right. You are now in the “Selection Bar”, a hidden screen element. Click once with the mouse button to select the line, as illustrated.

**Selection Techniques**

In many cases you need to select something within Word (such as applying formatting information to the selected item).

- Now the line is selected, apply a different font colour to the selected line.

Selecting a sentence

- Click within the second sentence of the second paragraph. Depress the Ctrl key and then click within the sentence, to select the sentence.

**Selection Techniques**

In many cases you need to select something within Word (such as a line of text), prior to applying formatting information to the selected item.

 Normally when using a Windows based product such as Word the golden rule is select first, then manipulate. However because Word recognizes the concepts of what a word is and what a paragraph is, in some cases you will not have to select first. Thus if you wish to apply font (i.e. word) formatting, such as making a word bold, then you only have to

- Now the sentence is selected, apply a different font colour to the selected sentence.

Selecting a paragraph

- Click within the paragraph starting with the words 'To Select A Character'.
- Click three times to select the paragraph, as illustrated.

  To select a character: Click just in front of the character you want to select. Press the Shift key (and keep it pressed). Press the right arrow key. Release the Shift key.

- Now the paragraph is selected, apply a different font colour to the selected paragraph.

Selecting all text

- Experiment with selecting all the text within the document by pressing Ctrl+A.
- Save your changes and close the document.
Inserting text
- Open a file called Editing Data.
- Within the second line, click in front of the word Star.
- Type in the letter A.
- Press the spacebar to insert a space. The sentence should now read 'the Sun Is A Star'.
- Within the first line, click in front of the word Word.
- Type in the word Microsoft.
- Press the spacebar to insert a space. The sentence should now read 'a Good Example Of An Application Program Is MICROSOFT Word'.

Modifying existing text
- Double click on the word David in the last line (to select it).
- Replace the selected name with your first name.

Removing existing text
- Click to the left of the last letter 's' in the word newspapers.
- Drag the mouse over the letter's, to select it. Release the mouse button. This letter will now be highlighted, as illustrated.

Remove the last letter (the letter 's') in the next sentence:
I have finished reading my newspapers

- Press the Delete button. The selected character is now deleted.
- In the next example we will delete a word rather than a single character. We will delete the word 'now'. You could use the same method outlined above to select a word, but there is an easier way. Double click on the word 'now' and as you will see this will select the word that you double clicked on.

Remove the word 'now' in the next sentence:
I have now finished tidying the kitchen

- Press the Delete button. The selected word is now deleted.
• Save your changes and close the document.

Finding text within a document
• Open a file called Searching.
• Click on the Edit drop down menu and select the Find command to display the Find And Replace dialog box.
• Type the text you wish to find in the Find What text box, in this case the word Excel.

Finding and replace text within a document
• Click on the Edit drop down menu and select the Replace command to display the Find And Replace dialog box.
• Type the text you wish to find and replace in the Find What text box, in this case the word Excel.
• Type the replacement text in the Replace With text box, in this case Microsoft Excel.
• Click on the Replace All button and this will replace all occurrences of the word as specified.
• Close the Find And Replace dialog box.
• Save your changes and save the file.

Copying text within a document
• Open a file called Copy Move Delete 01.
• Click three times within the first paragraph to select it.
• Click on the Edit drop down menu and select the Copy command.
• Move to the end of the document and click once.
• Click on the Edit drop down menu and select the Paste command.

Copying text from one document to another
• Click three times within the first paragraph to select it.
• Click on the Edit drop down menu and select the Copy command.
• Open a second document called Copy Move Delete 02.
• Within this second document, click at the position within the document where you wish to copy the selected text.
• Click on the Edit drop down menu and select the Paste command.

Moving text within a document
• Re-display the first document called Copy Move Delete 01 (by clicking on its button displayed along the bottom of your screen).
• Select the paragraph formatted using Arial Bold text.

Sample
To move text within a document: Select the text that you wish to move. Click on the Edit drop down menu and select the Cut command. Click at the position within the document that you wish to move the selected text to. Click on the Edit drop down menu and select the Paste command.

• Click on the Edit drop down menu and select the Cut command.
• Click at the end of the document.
• Click on the Edit drop down menu and select the Paste command.
Moving text from one document to another
- Select the paragraph formatted using Arial Bold text.

  To move text within a document: Select the text that you wish to move. Click on the Edit drop down menu and select the Cut command. Click at the position within the document that you wish to move the selected text to. Click on the Edit drop down menu and select the Paste command.

- Click on the Edit drop down menu and select the Cut command.
- Re-display the second document called Copy Move Delete 02 (by clicking on its button displayed along the bottom of your screen).
- Click at the position within the document where you wish to move the selected text to.
- Click on the Edit drop down menu and select the Paste command.
- Save your changes and close both files.

Deleting a character
- Open a file called Delete.
- Place the insertion point to the left of the very first character within the document and press the Delete key.

Deleting a word
- Double-click within the second word in the document and press the Delete key.

Deleting a line
- Select a line within the paragraph explaining how to delete a line by moving the mouse pointer in the left-hand margin and clicking once.
- Press the Delete key.

Deleting a sentence
- Select a sentence within the paragraph explaining how to delete a sentence.
- Depress the Ctrl key and click once to select the sentence.
- Press the Delete key.

Deleting a paragraph
- Select the paragraph explaining how to delete a paragraph (triple click to select the paragraph).
- Press the Delete key.
Deleting a block of text
- Experiment with selecting blocks of text within the last paragraph in the document (by dragging the mouse pointer over the text with the left mouse button depressed). Once the text is selected press the Delete key.
- Save your changes and close the file.

Using Undo to reverse your last action
- Click on the Undo button on the Standard toolbar. You should see the deleted item redisplayed!

Repeating an action using Redo
- Click on the Redo button on the Standard toolbar. You should see the action of the Undo button is reversed.

- Save the file changes and then close the file.
Formatting

Text Formatting

Changing the font size or font type

- Open a file called Text Formatting.
- Select the first line of text, as illustrated.

- Apply a different font to the selected text, and also make the font size larger, using the Font and Font Size buttons.

Formatting text as bold, italic or underlined

- Experiment with using the Bold, italic and underlined buttons within the Formatting toolbar.

- As directed within the document, format a line as bold.
- As directed within the document, format a line as italic.
- As directed within the document, format a line as underlined.
- As directed within the document format a line as bold, italic and underlined.
Applying subscript or superscript formatting

- Select the 2 in the line containing the equation $E=MC^2$.
- From the Format menu, click on the Font command. The Font dialog box is displayed.
- From within the Effects section of the dialog box, select the Superscript command.

- Click on the OK button to close the Font dialog box.
- Select the 2 in the line containing the equation $H_2O$.
- From the Format menu, click on the Font command. The Font dialog box is displayed.
- From within the Effects section of the dialog box, select the Subscript command.
- Click on the OK button to close the Font dialog box.
- The text should now look like this.

$$E=MC^2$$ is the famous equation equating mass and energy.

$H_2O$ is the chemical symbol for water.

Applying colours to selected text

- Select the first line of text again.
- Click on the down arrow next to the Font Colour button, which will display a drop down dialog box.

- Click on the colour you wish to apply (in this case Red). De-select the selected text to see the effect of your formatting changes!
Applying different background colours to selected text

- Select the last paragraph of text (by triple clicking within the paragraph).
- Click on the Format drop down menu, and select the Borders And Shading command.
- Within the dialog box displayed, select the Shading tab.
- Select the required colour (in this case select a yellow colour) and then click on the OK button.

![Borders and Shading dialog box](image)

Changing the text case

- Select the first line of text. Click on the Format drop down menu and select the Change Case command. From the dialog box displayed, select the required case, (in this case Uppercase) and then click on the OK button.

SAMPLE
• Save your changes and close the document.

Setting hyphenation options
• Open a document called Adjusting Hyphenation.
• If necessary change to ‘Print Layout’ view.
• To see how hyphenation has been set on your PC, click on the Tools drop down menu and select the Language command. From the sub-menu displayed select the Hyphenation command. This will display the Hyphenation dialog box.

• To automatically hyphenate a document, click on the "Automatically Hyphenate Document" check box. Click on the OK button.

• Close the dialog box and continue. You should find that the document which originally looked like this:
Changes, so that the hyphenation is displayed, as illustrated below.

- Before continuing turn off automatic hyphenation.
- Save any changes you have made and close the document.

Paragraph Formatting

Deleting a paragraph
- Open a document called Paragraph manipulation.
- Triple click within the second paragraph to select it.
- Press the Del key to delete the second paragraph.

Creating a paragraph
- Click at the end of the first paragraph.
- Press the Enter key a few times. Each time you press the Enter key, you insert a new paragraph mark. Click on the Show/Hide button within the Word toolbar to see the paragraph marks.
• Click on the Show/Hide button again to hide the paragraph marks.
• Enter a few lines of text to make up the second paragraph. You may need to press the Enter key so that empty space is displayed after the paragraph.

Merging paragraphs
• Click at the end of the second paragraph of text.
• Press the Del key a few times until the third paragraph merges with the second paragraph.
• Save your changes and close the document.

Inserting a soft carriage return (manual line break)
• Open a document called Line breaks. Insert a line break within the top line of text so that all text after the comma is displayed on the next line down. To do this click just after the comma within the first line, and press the Enter key while depressing the Shift key.
• Click on the Show/Hide button to display the line break character, and you should see the following.

REM
SAMPLE

Removing a soft carriage return (manual line break)
• The second line contains a manual line break. Click just before the manual line break character and press the Del key.
• Re-click on the Show/Hide button to hide the line break character.
• Save your changes and close the file.

Good practice when aligning and indenting text
• Text can be aligned to the left or to the right. It can also be centred or justified. If you justify text, Microsoft Word inserts extra spaces into the lines of text so that the left and right edges of the text line up vertically, you do not see a ragged edge down the right side of the text.
• When aligning text use the tools that are built into Microsoft Word. For instance if you wish to centre a paragraph, as we shall see you could click within the paragraph and then click on the Centre button. You should not insert spaces or tab stops and try and line up paragraphs visually.
• The same advice applies to indenting. There are indent buttons you can use rather than repeatedly pressing the spacebar to indent text.

**Aligning text within a document**

• You can use the alignment buttons to align paragraphs:

```
Align to the left:

Centre

Align to the right:

Justify
```

• Click within the first line and align the text to the left.
• Click within the second line and align the text to the right.
• Click within the third line and centre the text.
• Click within the last line and justify the text.
• Save your changes and close the file.

**Indenting a paragraph from the left**

• Open a document called *Indenting*.
• Click within the first paragraph.
• Indent the first paragraph of text using the *Increase Indent* button on the toolbar.

```
    
```

• Click on the *Increase Indent* button a few more times to increase the indent.
• Click on the *Decrease Indent* button a few times to decrease the indent.

**Indenting a paragraph from the right**

• Click within the second paragraph.
• Click on the *Format* drop down menu and select the *Paragraph* command. This will display the *Paragraph* dialog box, as illustrated below.
Within the **Indentation** section of the dialog box, enter a value to indent the paragraph from the right and then click on the **OK** button. The indented paragraph will be as illustrated below.

**Indenting the first line of a paragraph**

- Click within the third paragraph.
- Click on the **Format** drop down menu and select the **Paragraph** command. This will display the **Paragraph** dialog box, as illustrated below.

Within the **Indentation** section of the dialog box, click on the down arrow within the **Special** section. Select **First Line**.
Click on the OK button and the first line of the paragraph will be indented.

Save your changes and close the file.

What are 'Tab Stops'?

In early versions of Microsoft Word, using 'Tab Stops' was a vital method for formatting particular items within a Microsoft Word document. Tabs were commonly used for displaying columns of data, with each column of data being separated from the next column by a tab space.

As newer versions of Microsoft Word have been released over the years the use of tab stops within a document has lessened, as Microsoft Word will now automatically insert tab spaces into document elements such as a 'table of contents'. Microsoft Word 2003 also has many pre-designed pages available to you such as customisable front pages, which again makes the need to manually insert tab stops less important than it used to be in earlier versions of Microsoft Word.

When you create a new, blank document, by default the Ruler does not contain tab stops.

Types of tabs

Tab types include:

Left Tab stop:
This sets the starting location of text which will display to the right as you type
text into this tab stop location.

**Centre Tab stop:**
This sets the position used for the middle of the text, which will centre on this tab stop as you type in text.

**Right Tab stop:**
This sets the right end for your text and when you enter text at this tab stop it will move to the left.

**Decimal Tab stop:**
This is used to align numbers around a decimal point.

**Bar Tab stop:**
This displays a vertical bar at the tab stop location.

**NOTE:** There are two more options, but these relate to indents rather than tab stops.

**Indent First Line:**
Click on this control and then click on the top part of the horizontal ruler where you would like the first line of that paragraph to begin.

**Hanging Indent:**
Click on this control then click the bottom half of the horizontal ruler where you would like all the lines after the first line of the paragraph to be indented to.

To move a Tab Stop left or right you can drag it using the mouse pointer (with the mouse button pressed down when you are dragging the tab stop).

To delete a Tab Stop, drag it off the Ruler (with the mouse button pressed down when you are dragging the Tab Stop).

**Setting tabs using the Ruler**
- Open a file called *Tabs*.
- Click on the *Show/Hide* button so that you can see the tab stops displayed.
- To move the tab stops select all the text and drag the Tab stops (as displayed within the Word Ruler) to the left or right.
• Click at the end of the document and experiment with inserting tab spaces. Experiment with entering text into these tab spaces.
• Save your changes and close the file.

Removing tabs using the Ruler
• Select the paragraph in which you want to clear or move a tab stop (tab stop: A location on the horizontal ruler that indicates how far to indent text or where to begin a column of text.).
• To clear a tab stop, drag the tab marker down from the horizontal ruler (horizontal ruler: A bar marked off in units of measure (such as inches) that is displayed across the top of the document window.).
• To move a tab stop, drag the tab marker to the right or left on the horizontal ruler.

Good Practice: Use paragraph spacing rather than using the Enter key
• It is considered better practice to use Word templates with fairly large pre-set paragraph spacing. This means there is less need to press the Enter key to insert visual spacing between each paragraph.

Modifying paragraph spacing
• Open a file called Paragraph spacing.
• Click within the second paragraph. Click on the Format drop down menu and select the Paragraph command.
• This will display the Paragraph dialog box.
• Within the dialog box, change the **Spacing** section of the dialog box, increase the value of the spacing **Before** and **After**, as required.

• Click on the OK button and observe the effect.
• Experiment with modifying the spacing above and below the different paragraphs within the document.
• Save your changes and close the file.

**Modifying line spacing**
• Open a file called **Line spacing**.
• Click within the first paragraph. From the **Format** drop down menu, click on the **Paragraph** command to display the **Paragraph** dialog box.
• Within the **Line Spacing** section of the dialog box, set the line spacing to **Double**.
• Click on the **OK** button to apply your changes.
• Click within the second paragraph and apply a line spacing value of **1.5**.
• The third paragraph already has a line space value of **2**: Change this to a line spacing value of **1**.
• Save your changes and close the file.

---

**Applying bullets to a list**

• Open a file called **Bullets and numbering**.
• Select the list of **Countries**, as illustrated.
• Click on the **Bullets** tool within the **Formatting** toolbar, to apply bullet formatting to the list of countries.

• Click outside the selected list so that it is no longer selected. The list will now look like this.

- **Countries**
  - United States
  - United Kingdom
  - Germany
  - Spain
  - Mexico

---

### Removing bullet formatting from a list

- Select the list of **Cities**.

- **Cities**
  - London
  - Paris
  - New York
  - Berlin
  - Sydney

• Click on the **Bullets** button on the **Formatting** toolbar. This will remove the bullet formatting that has been applied to the list of cities.

---

### Adding numbering to a list using the Numbering button

- Select the list of **Continents**.
Click on the Numbering button from the Formatting toolbar.

This will apply number formatting to the list, as illustrated.

Removing number formatting from a list

- Re-select the list of continents and re-click on the Numbering button. This will remove the number formatting of the list.
- Save your changes and close the file.

Applying a different bullet or numbering style to a list

- Open a document called Customised bullets and numbering.
- Select the list of Countries.

From the Format menu select the Bullets And Numbering command, which will display the Bullets And Numbering dialog box.
• The **Bulleted** option tab should be displayed, if not, select it. A list of different bulleted styles will appear.

• Select a bullet style from the **Bulleted** folder such as the arrowed bullets illustrated above. When you click on the **OK** button the list will look like this.

```
Countries
  ➢ United States
  ➢ United Kingdom
  ➢ Germany
  ➢ Spain
  ➢ Mexico
```

• Select the list of **Cities** and apply a different type of bullet, as illustrated below.

```
Cities
  ✔ London
  ✔ Paris
  ✔ New York
  ✔ Berlin
  ✔ Sydney
```

• Select the list of **Continents**. From the **Format** menu select the **Bullets And Numbering** command, which will display the **Bullets And Numbering** dialog box.
Select the **Numbered** tab and a list of different numbering styles will be displayed. Apply a different numbering format, such as the one illustrated below.

![Image of Bullets and Numbering dialog box]

- When you click on the **OK** button your list will now look like this.

```
Continents
I  Africa
II Europe
III Asia
IV Australia
```

- Save your changes and close the file.

**Adding a border using the Border button**

- Open a file called **Borders**.
- Click within the main body of text. Click on the **Outside Border** button.
- You should see a border displayed around the text.

Adding a Page Border
- From the Format menu, select Borders And Shading. The Borders And Shading dialog box is displayed with the Borders tab displayed.

- Select the Page Border tab and from the Setting section of the dialog, select the required effect, i.e. Box, Shadow, 3-D etc.
You can select from a range of line Styles.
You can select from a range of Colours.
You can select from a range of line Widths.
You may also select a range of Art effects.

- Experiment for a while! The page border will look like this.

- Save your changes and close the file.

Adding shading
- Open a file called Shading.
- Select the document title.
• Select **Borders And Shading** from the **Format** menu. The **Borders And Shading** dialog box is displayed. Select the **Shading** tab.

![Borders and Shading dialog box](image)

• Experiment with applying different shading options to the selected text. A typical effect is illustrated below.

![Sample shading](image)

• Save your changes and close the file.
Styles

Applying character styles
- Character styles only contain character formatting information such as font type, font size, font style, font effects (i.e. small caps, subscript or superscript), character spacing plus text borders and shading. They are normally used by standard Word features such as page numbering and hyperlinks.

Applying paragraph styles
- Paragraph styles contain formatting information that can be applied to a paragraph. They include paragraph formatting, such as alignment and indentation. They can also contain character formatting information that you wish to apply to an entire paragraph, such as font type, size and colour. Paragraph styles can be applied to any text within the body text area of the document, as well as to headers, footers, footnotes and other elements such as a table of contents or index.
- Open a document called Styles.
- To apply a style you click on the down arrow to the right of the Style box to display the Style List box, and then select a style and it will be applied to the selected text.

Follow the instructions within the document and apply different styles.

Apply a Heading 1 style to the first paragraph.
Apply a **Heading 2** style to the second paragraph.

Apply a **Heading 3** style to the third paragraph.

- Save your changes and close the document.

---

**Copying formatting using the Format Painter.**

- Open a document called **Format painter**.
- Select the first paragraph, which has been previously formatted.
- Click on the **Format Painter** button.

![Format Painter](image.png)

- You will notice that the mouse pointer shape has changed to the shape of a small painting brush. Position the mouse pointer at the end of the second paragraph.
- Press the mouse button and while keeping the mouse button pressed move to the start of the paragraph.
- Release the mouse button and the formatting contained within the first paragraph will be copied to the second paragraph.
- Save your changes and close the file.
Objects

Table Creation

Creating a table using the Insert Table button

- Open a document called Tables.
- As instructed within the document, click below the first line of text and create a table *that contains 5 rows and 3 columns*. To do this click on the Insert Table button and drag the mouse over the grid to select the number of rows and columns you require.

- The screen will change as illustrated.

- When you release the mouse button the table will be inserted into the document.

Entering data into a table

- Click on the first cell within the table.
• Enter your first name. Move to all the other cells in the table and enter a different name in each cell. To move from cell to cell you can use the Tab key.
• Within the first cell click at the end of your first name. Press the spacebar to insert a space and then type in your second name.
• Double click on a name within another cell. This will select the name. Type over the original name with a new name.

NOTE: You can enter numbers as well as text into table cells.

Selecting elements within a table, using the Table drop down menu
• Experiment with selecting rows, columns and the entire table. To do this, first click within the table, in the cell, row or column that you wish to select, and then click on the Table drop down menu, click on Select and from the sub-menu; select the required item, Table, Column, Row or Cell.

• Before continuing, make sure that you have practiced:
  - Selecting a cell.
  - Selecting a row.
  - Selecting a column.
  - Selecting the entire table.

Inserting a column into a table
• Select the second column within the table.
• Click on the Table drop down menu, select the Insert command. From the sub-menu select the Columns to the Left command.
Inserting a row into a table

- Select the second row within the table
- Click on the Table drop down menu, select the Insert command. From the sub-menu select the Rows Above command.
End of the preview sample

This sample is approximately half of the full course. Please see the table of contents at the beginning of this document to see the full list of topics covered in the full course. To purchase the rights to use the full training manual at your training centre please see our web site at:


A courseware licence allows you to make unlimited copies for use at your training centre. In addition you get HTML formatted versions of each course, included with our printable courseware.